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Frequently Asked Questions 
 
 
Q: During the test when I go to View, Channel  Load, the real time display of the load versus time 
shows a graph with data all over the place instead of the expected cyclic load. Is it electrical noise, 
or is the system not working properly?  
  
 
A:  The Channel Monitor option under the View menu is a feature of all of Geocomp's program that it 
is used as a diagnostics tools to monitor the real time display of any sensor connected to the system.  
This feature is not used to monitor an actual cyclic test running for the following reason: 
 
1. The refresh rate of the Channel Monitor screen is limited to 1 sec.   
 
 

 
 
 
2. The cyclic test is running with a data acquisition of 200 readings per 1 sec .  
 
3. While the test is running, 200 data points are being recorded in a span of 1 sec, whereas the channel 
monitor is refreshing every one second. Therefore, the real time display is not in synch. 
 
To view the test results, you must wait until the test is finished, load the file, and go to Report.  
Select either Debug or Raw Data.  Now you can graphically see the actual recorded test data. 

 
 
 
Q: When I view the System Monitor before starting the test, there is always about ± 0.005 kN  (0.1 
lb) load in the vertical direction. Why?  There is no contact between the vertical load cell and the 
specimen, so why is there a small fluctuation in the load and how can I make it zero? 
 
A:  There is always going to be a small load fluctuation of about 0.025% of load cell full capacity. 
To re-zero the load cell, please follow these steps: 
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1. Go to the System Monitor, and record the analog reading of the vertical load cell when it is at the 
no load condition (when the load cell is not in contact with anything). 
2. Go to Calibrate Summary. 
3. Overwrite the Offset value for the vertical load cell with the analog reading value from step one. 
4. Click on the Apply and Ok buttons. 
5. You should now see in the System Monitor that the vertical load cell is virtually zero. 
 
Note: This re-zeroing process can be applied to other sensors such as a pressure transducer. 
 
 
Q: When I use report soft ware, the scale does not change as I want. For example, if I want to 
change the vertical displacement scale to say negative 0.02, it will not change, but if I change it to 
negative 0.2 it will change. (In this particular case the default minimum value is negative 0.05). A 
similar thing happens to the stress scale too. 
 
A: The software tries to keep both the vertical and horizontal scale in a ratio of 1:1 so that the Mohr 
circles are actually circles not ovals. 
Thus, there are values in the scaling that are not acceptable to the software. 
You may have to keep on trying different values. 
 
 
Q: After running a successful test we ran into troubles with the report. We were not able to 
generate a report because all links on the report pull-down menu are inactive. Are we missing 
something, or is the software not entirely installed?  
 
A: Once a test is finished, or even while it is running,  
1. Go to the File menu.  
2. Click on Load; this will load the test data on the open window on the desktop. 
3. Go back to Report. You should see now the Graph, Settings, and Edit menus all activated. 
4. You can change units and scales, and edit the test data points. 
5. Remember that every time you change or edit something, you will need to save the file, and load it 
again. 
 
 
Q:  What does PID mean?  

 
A: PID CONTROL  
 
 Control of the pressure or load is accomplished by using a closed loop controller. At equally 
spaced time intervals called the control loop period, the controller compares the target load or 
pressure to the measured load or pressure. The loop error is the difference between the two. The 
controller uses this error to compute and send a signal to the micro-stepper motor in order to make 
adjustments to reduce the error by the next loop period. 
 
 The signal to the micro-stepper controls the micro-stepper’s position. The loop error computed 
by the controller at every loop period is nothing but the additional required load or pressure to 
eliminate the error by the next loop period. In other words, the load rate is the error divided by the 
loop period. 
 
 Signal = Error / Loop Period / Stiffness  
 
 GP = 1 / Loop Period / Stiffness  
 
 Signal (P) = GP * Error 
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The above equation is the basic idea behind any proportional controller where GP is the proportional 
gain. 
 
 The controller employed by this system is actually a PID controller, where P is for proportional 
control, I is for integral control and D is the derivative controller. 
 
The PID control parameters are adjustable due to the nature of the different soil types and large 
variations in their stiffness, from very soft peat and organic soils to highly over-consolidated clays or 
even soft to medium rocks. 

 
 
Q: All values for the sensors under View System Monitor show values about 32000, and no sensor 
seems to be active.   
 
 
 
A: Possible causes are: 
 

1. The SCU box is turned off 
2. There is no physical connection between the SCU and the PC 

 
If the values shown are zeros, check to make sure that: 
 

You have loaded a template file or a previously run test 
 
 
Q: We have several units connected to the same PC. We were running only one of the units, so we 
shut off the remaining units.  Then we got an error message stating that the unit was not 
responding. It seems that we lost communication with the unit. What is happening? 
 
A:  A temporary loss of communication is a normal thing when you either shut off or boot up another 
unit connected to the same network. Any time a unit connected to the network is powered down or 
powered up, the network goes into a re-configuration mode, during which no communication is 
allowed. Depending on how many other units are on, this process may take some time. If you're lucky, 
the Windows software will miss it.  If you're not so lucky, you get the normal 'LoadTrac not responding' 
message. All you have to do is hit the Retry button and you should be all set. 
 
 
Q: I noticed that the engineering readings on the LCD screen are different than the ones on the PC 
screen.  Are they supposed to be the same? Did it affect the results of a test I just ran? 
 
A: SYNCHRONIZING LCD AND PC SCREENS: 
First, I would like to assure you that the mismatch of the engineering readings values between the LCD 
and the PC screens will not affect the results of any test that you have run through the PC software 
program. 
 
Assuming that your calibration factors are correct, or that you have just finished a new calibration and 
need to update the calibration parameters on the embedded controller of a LoadTrac-II or FlowTrac-II 
or ShearTrac-II, you can synchronize the engineering readings between the LCD and the PC screen by 
following these steps: 
 

1. Go to the Calibrate Summary menu 
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2. Select the sensor that you want to synchronize 
 

 
 
 

3.Click on the Download button. This will automatically transfer (copy and save) the 
current calibration parameters (Factor and Offset) into the embedded controller.  
4.Repeat the above procedure for the other sensors. 
You should now see that the PC and LCD screen values match. 

 
 
Q: After an electrical power problem, it seems that the system is not working properly. We suspect 
that the set-up values on the embedded controller are not correct.  How do we revert to the 
original set-up values or default values set at the factory? 
 
A: The default values may change either after an electrical power problem or due to inadvertent 
actions by the end user. 

 
You will need to revert back to the internal default values of your system by following these easy 
steps: 

1. Turn off the LoadTrac-II (or FlowTrac-II or ShearTrac-II) unit. 
2. Wait about 10 sec. 
3. Turn it back on and immediately press the ESC key on the keypad to reset everything 

back to the default values. 
4. You may have to manually reenter the Node ID number. (For example, the default 

value for the LoadTrac-II is 65.) 
 
 
Q:  Can the software detect wrong values that are manually entered by the end user? 
  
A: Yes, the software program detects any erroneous data entry; examples include: 
  

1. Negative values for sample dimensions, calibration factors, and PID control parameters 
2. Zero values for sample dimensions, calibration factors (except for offset value), and 

PID control parameters 
3. Wrong Node ID number 
4. A malfunctioning sensor that it is giving an analog reading of either 0 (the minimum value) or 

65535 (the maximum value) 
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5. Any unit (LoadTrac-II or FlowTrac-II) that is not on. 
 
 
Q: I am running a test. Do I need to wait until the end of the test to see the results? 
  
A: You do not need to wait until the end of the test.  While the test is running: 

1. Go to the File menu. 
2. Select Load. 
3. Go to the Report menu.  You should now be able to see the partial data up to the point when 
you did the Load. 
5. Repeat the above steps as the test progresses. 

 
 
Q: In many of our different test files, the calibration values in the Summary Table and the values in 
each sensor's individual calibration table are not in sync.  Could you please explain which values 
the program uses, and how to make sure they are correct?   
 
A:  All of the Geocomp control programs have similar menus for performing the calibration of any of 
the sensors related to the test.  However, you must then copy the calibration that you obtained into 
the Summary Table.  (If you have had to repeat the calibration procedure, be sure to use the correct 
value.) 
 
The calibration factors in the Summary Table are the ones that the particular program uses when 
running a test. 
  
Note that it is possible to have no calibration data in the calibration menu if you calibrate a sensor 
with one program (for example, ICON) and later use a different program (for example, SHEAR): Each 
program will always uses the calibration factors contained in its Summary Table. 
 
Q: Can the data in the Report Summary Table be transferred into the MS Excel? 
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A. Yes. You can by going to Report- Table, then right click Select all Copy and Paste into 
Excel Spread sheet.  In Excel you must go to   Data  Text to Columns to parse the data. See 
below. 
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Q. In Report Table only last 5 steps can be seen in each cycle, is it possible to see the other steps 
also? 
 
A. The only way to see all the data is to use the Dump option under the File menu. Please note that 
Microsoft Excel has a limit of 65536 rows. 
 
Q. I noticed in the summary graph/table that the applied or mean deviator stress is off from the 
target or nominal stress. Is this going to affect the resilient modulus results? 
 
A.  Being a ratio of stress difference over strain difference, the resilient modulus value will not be 
affected if the applied stress is off the target. 
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RM =   Δσ/Δε 
 
 
 

 
 

 
 

Q. We would like to know about the default 1,2,3,4 equations which are being used for 
calculating the Mr value. Is it also possible to show the explicit equation of in the help file?  
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A. The equations will be shown in the help menu in the future, right now. The equations are from: 
AASHTO PUBLICATION NO. FHWA-RD-97-083:  
Design Pamphlet for the Determination of Design Subgrade in Support of the 1993 AASHTO Guide for the 
Design of Pavement Structures. 
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Q. The Network LED is RED on the front panel and there is no communication between the PC and 
the frame, all of our ID numbers are correct, what else should we check? 
 
A. The network communication cable (gray cable) must be plugged into the Ethernet plug on the back 
of the PC instead of the network communication card that we provided. Please unplug the cable and 
replug into the card. The LED should turn into solid green. 
 
 
Q. In some steps the nominal deviator stress is different that the mean deviator. Is this something 
to worry about?  
 
 
A. Even if the applied load (or stress) is off target, the value of the resilient modulus is still CORRECT, 
because the resilient modulus is equal to the change of stress divided by the change of strain according 
to the following equation: 

RM =   Δσ/Δε 
 
 

Q. We are experiencing some vibrations during the rest period; the soil that we are testing is very 
stiff. Is there anyway to reduce these vibrations? 

 
The vibration that you are experiencing can be reduced or/and eliminated all together by zeroing the 
Update Cycle number under TEST PARAMETERS. However; you will have to start the test with a 
Proportional Gain under OPTIONS ACTUATOR slightly different depending on the material stiffness. 
For example for a  stiff material  you start with a P-Gain = 0.10,  and for  a soft material you can go up 
to  0.3 or even higher   up to 1  if  the  material’s RM is less than 700 kPa (1000 psi). 
The update cycle value of 1 forces the system to automatically update the P-Gain each 1 cycle.  
Sometimes the sample stiffness changes rapidly, and as the result the system cannot keep up with it 
and goes into the vibration mode that you are experiencing specially toward the end of the test which 
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in your case corresponds to the high stresses. By zeroing the Update Cycle you will be keeping a 
constant P-Gain throughout the test which will definitely prevent the system from vibrating. 

 
Please note that there is delicate balance in fine tuning the system whose optimal performance heavily 
relies on the stiffness of the material being tested. This is why there is a conditioning phase of the 
test, you could conceivably check the system performance during the conditioning phase, readjust the 
P-Gain lower or higher if the system is overshooting or undershooting and then rerun the test. 
 
 

Q.  What are the effects and correlations between the PID values? 
 
A. Effects of each of controllers P-Gain, D-Gain, and I-Gain on a closed-loop system are 
summarized in the table shown below.  

CL RESPONSE RISE TIME OVERSHOOT SETTLING TIME S-S ERROR 

P-Gain Decrease Increase Small Change Decrease 

        I-Gain Decrease Increase Increase Eliminate 

        D-gain Small Change Decrease Decrease Small Change 

Note that these correlations may not be exactly accurate, because P, I, and D are dependent 
of each other. In fact, changing one of these variables can change the effect of the other 
two. For this reason, the table should only be used as a reference when you are determining 
the values for P, I and D.  
 
 
Q. Although the Instruction Manual advises not to change the default PID values, the 
Troubleshooting section at the end of the booklet suggests different PID values for use 
with soft and hard samples? Is it possible to use other values than the three choices given? 
If so, how are we going to decide on what values to use? Please clarify. 
 
A. The default values work for most of the soils; however in some case they do need to be 
fine-tuned to reflect the soil out of the normal range of stiffness such as for soft organic or 
highly stiff clays. So yes, you can change them by exercising caution (small increment in 
change at a time)  in doing so. 
 
 
 Q. How does  the stiffness of the sample correlate with the P-Gain ? 
 

A. There is a direct correlation between the soil stiffness and the P-Gain when it comes to the 
applied vs. the target stress and the convergence time.  The response time of the closed-loop 
control will increase by increasing the P-Gain under.  
 The higher the P-Gain the faster the load is applied; however the control may 
overshoot the target load depending on the stiffness of the soil. This gain can be changed on 
the fly while the test is running if further fine-tuning of the control is deemed necessary. You 
should use increments of 0.5 or less at a time. The trade off is that when a load specially a 
high one is applied rapidly, the soil if it is a very soft one can be “shocked” and it is a very 
stiff one, the load may  take time to converge to the target value by a steeper over and under 
shots.   
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Sample stiffness Recommended P-Gain value  

LOOSE /VERY SOFT 5.0 

MEDIUM SOFT/MEDIUM 2.0 

DENSE/STIFF 0.5 

 
Typical Elastic Moduli E, and Shear Moduli G values for soils are: 
 

SOIL TYPE Description E  kPa,  G kPa, 

 
CLAY 

Soft 1000-15000 500-5000 

Medium 15000-30000 5000-15000 

Stiff 30000-100000 15000-40000 

Very Stiff > 100000 > 40000 

 
SAND 

Loose 10000-20000 5000-10000 

Medium 20000-40000 10000-15000 

Dense 40000-80000 15000-35000 

Very Dense > 80000 > 35000 

 
 

The default values are the recommended values that should work  with the majority of soils. 
The following diagrams illustrate  the effect of the PID control on different soils stiffnesses. 
See illustrative graphs. 

Soft or Loose Soil Samples 

Load or Stress vs. 
Response Time 

 
 
 
 
  
 
 
 
 
 
 
 

 Stiff or Dense Soil Samples 

Load or Stress vs. 
Response Time 

 
 
 

 
 
 

 

P-Gain Low = SLOW 

P-Gain High = FAST 
P-Gain Low = SLOW 

P-Gain High = FAST 


